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1. Introduction 
This tutorial guides you through the complete construction of a very basic Aspen HYSYS 
steady state simulation. To see the completed exercise, you can open the file Sweet Gas 
Refrigeration Plant.hsc in the Aspen HYSYS\Samples folder. (Tip: Click Examples from the 
Get Started ribbon to open the folder.) Several other completed cases are included with 
your Aspen HYSYS package. 

This simulation will show you how to: 

1. Set up the units of measurement.  

2. Select the chemical components from the component library. 

3. Choose a property package (a set of calculation methods). 

4. Enter the Simulation environment. 

5. Add and define the feed streams. 

6. Add and define the unit operations leading to the column. 

7. Add and define the column operation. 

8. Set up monitoring and reporting operations to record results. 

Once the results for the simulation are obtained, you will have a good understanding of 
the basic processes used to build a HYSYS simulation case.  
Note: Due to regular updates, changes, and improvements in Aspen HYSYS releases, the 
calculation results in your simulation may vary slightly from those in the tutorial. If you are not 
getting the same results as those in the tutorial, please proceed anyway. It is more important that 
you get the end-to-end overview of the basic HYSYS setup and simulation process than to match 
the results of this particular case. 
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1.1 About This Case 
The case models a sweet gas refrigeration plant with an inlet separator, a gas/gas heat 
exchanger, a chiller, a low-temperature separator and a de-propanizer column. 

In the simulation, a natural gas stream containing N2, CO2, and C1 through n-C4 is 
processed in a refrigeration system to remove the heavier hydrocarbons. The lean, dry 
gas produced will meet a pipeline hydrocarbon dew point specification. The liquids 
removed from the rich gas are processed in a depropanizer column, yielding a liquid 
product with a specified propane content. 

The flowsheet for this process appears below. 

 
First, two feeds are combined in a mixer. The mixer-combined feed stream then enters an 
inlet separator, which removes the free liquids. Overhead gas from the separator is fed to 
the gas/gas exchanger, where it is pre-cooled by refrigerated gas. The cooled gas is then 
fed to the chiller, where it is further cooled by exchange with evaporating propane 
(represented by the C3Duty stream).  

In the chiller, (modelled using a cooler operation) enough heavier hydrocarbons condense 
so that the eventual sales gas meets a pipeline dew point specification. The cold stream is 
then separated in a low-temperature separator (LTS).  

The dry, cold gas from the LTS is fed back to the gas/gas exchanger and then to sales, 
while the condensed liquids from the LTS are mixed with free liquids from the inlet 
separator. These liquids are processed in a depropanizer column to produce a low-
propane-content bottoms product.  

1.1. New Case and Session Preferences 
Now you will start a new case file for the tutorial simulation you will build. Close any open 
cases, and from the File menu select New > Case. 

A new HYSYS case starts in the Properties Environment, because you will need to define 
the components and calculation methods involved before you place any unit operations on 
a flowsheet. You’ll see Properties selected in the Navigation pane, on the bottom left of 
the screen. The navigation tree for the properties environment shows two items, 
Component Lists and Fluid Packages, with red icons, meaning that they are not yet 
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defined. These two have the red flag because they are the 
minimum required setups needed to enter the simulation 
environment and begin a simulation. The other selections, Oil 
Manager, Reactions and the rest, are optional, which is why 
they are marked with the OK status even though they are 
undefined. 

You will define the component list and fluid package for the new 
case in sections 1.3 and 1.4 respectively. First, however, you 
will define a units of measure set. 

1.2. Create a New Unit Set 
HYSYS has several different default unit sets that cannot be 
edited. If you want to edit the units when starting a case, you 
can clone one of the sets and assign the cloned set to the 
simulation. For this example, you will make a new unit set 

based on the HYSYS Field set, which you will then customize. 

To create the new unit set,  

1. Click File > Options. (Options is a button on the lower right pane of the File 
window.) 

2. In the Simulation Options property view, click 
Units of Measure. 

3. In the Available Unit Sets group, select the Field 
set and click Copy. A new unit set named 
NewUser is created.  

4. In the Unit Set Name field, enter a custom name 
for the new unit set, e.g. GasProcess, and press 
Enter. You can now change the units for any 
variable associated with this new unit set. For 
this example, in the Display Units group (top of 
the page) scroll down the list until you find Molar 
Flow. The default setting is lbmole/hr. A more 
appropriate unit for the Flow in this case is 
MMSCFD. 

5. Open the drop-down list in the cell beside the 
Molar Flow cell. Scroll down through the list and 
select MMSCFD. Your new unit set is now defined.  

6. Click OK to close the property view.  

Selections take effect as soon as you make them in the dialog box. The current state of 
preferences becomes the state for all cases subsequently opened or created. 

Figure 1 – Undefined Component 
Lists and Fluid Packages 

Figure 2 – Making a Custom Units Set 
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Note: The default settings are stored in a file called HYSYS.prf. You can optionally save 
changes in a new Preference file by clicking the Save Preference Set button. HYSYS 
prompts you to provide a name for the new Preference file, which you can later load into 
any simulation case by clicking the Load Preference Set button. 

1.3. Add Components to a Component List 
Now you will add the component compounds for the gas processor to a component list.  

When a new case starts, HYSYS is open to the Properties Environment - Component List 
window by default. If it isn’t open to the Component List window, click Component Lists in 
the navigation pane to bring it up. 

Click the down arrow next to the Add button, and select HYSYS from the drop down list. 
(Here, you are choosing between the HYSYS component libraries and the Aspen Properties 
component libraries.) A new window appears which includes a list of components and an 
Add > button. This is the editing window for the new component list. Also, in the 
navigation pane, a new line is created for the new component list – “Component List 1.” It 
shows the red icon since it is not yet complete. 

 
Figure 3 – Add Components to the Components List 

For this tutorial, you will add the following components: N2, CO2, C1, C2, C3, i-C4 and n-
C4. 

First, you will add nitrogen.  

1. Set the Search by box to Full Name/Synonym. 

2. In the Search For field, type Nitrogen.  

HYSYS filters as you type and displays only components that match your input. 

3. With Nitrogen selected, click the Add button to add it to the current composition 
list. You can also use the Filter options to display only those components belonging 
to certain families.  

4. Now add the rest of the components needed for the case: CO2, and C1 through n-
C4.  

5. Add the CO2 component to the component list.  
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6. To add the remaining components C1 through n-C4 using the filter, set the Filter to 
Hydrocarbons.  

You can drag the cursor down the name list and multiple-select C1 through n-C4. 
(You can also unselect using CTRL in the usual way.)  

7. Click Add. These components are added to the list. Notice that because 
“Component List – 1” in the navigation pane now contains components, it is 
checked as complete. 

Tip: Multiple Component Lists 
A case needs at least one component list, but as a simulation grows more complex you 
may find it useful to create more component lists dedicated to different component types. 
For example, a stream that carries only a coolant such as water or a refrigerant will solve 
faster if it sources a component list with only the coolant in it, rather than a list with the 
coolant and every other component in the simulation. You may also want to consider 
choosing different property packages for different component lists, as each property 
package is most accurate for specific components. 

Tip: Viewing or Editing Component Properties 
To view the properties of a component, double click it in the 
list. HYSYS opens the property view for the component you 
selected. The Component property view only allows you to 
view the pure component information.  

You cannot modify any parameters for a library component, 
however, HYSYS allows you to clone a library component as 
a Hypothetical component, which you can then modify as 
desired.  

1.4. Selecting the Property Methods to Create a Fluid Package 
Now that you have defined the component list you can complete the setup by associating 
it with a property package. A property package includes the equations used to model 
thermodynamic behavior of pure compounds and mixtures. There are different property 
packages available in HYSYS, as different equations are better suited to accurately predict 
the behavior of different systems. The most commonly used are the Equations of State 
property packages, specifically the Peng-Robinson package. 

When you join a component list with a property package, you create a fluid package. It is 
the fluid package that carries all of the information needed to start defining the simulation 
on the flowsheet. 

Figure 4 – Viewing component info. 
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To create the fluid package: 

1. Click Fluid Packages on the navigation pane. In the Fluid Packages window, click the 
Add drop down list and select HYSYS. (The HYSYS property package library). The 
new fluid package definition is added to the navigation pane with the default name 
of Basis-1.  

2. From the Property Package Selection field, select Peng-Robinson. The optional 
setups available for the Peng-Rob method appear to the right of the list1.   

3. Since there is only one component list defined for this simulation, it appears by 
default as selected in the Component List Selection pull down. (If you had more 
than one Components list you’d use this field to match the comp list with a property 
package.) When a property package and a component list are selected, the fluid 
package is defined.  

The red icon on the “Basis-1” list in the navigation pane turns to a blue check, indicating 
the fluid package is ready. 

 
Figure 5 – Component List and Fluid package defined 

Tip: Multiple Fluid Packages 
As with the component lists, you can create more than one fluid package. A larger 
simulation comprised of several flowsheets may warrant several specialized fluid 
packages, each assigned to a specific stream or subflowsheet.  

Definitions for review: 
Component List A list of chemical components from the components library 

that will be used in the simulation. 

Property Package A collection of calculation methods HYSYS will use to 
determine values for different variables.  

Fluid Package The combination of a Component List and a Property 
Package.  

 

                                                           
1Depending on what is required in a specific flowsheet, you might want to adjust these options, or add other advanced 
information such as reactions and interaction parameters to the fluid package. But the minimum requirements are a 
selected property package, and a component list. 
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1.4.1. Save the Case 
Before proceeding, save your case by selecting Save from the File menu, or pressing Ctrl 
S. If this is the first time you have saved your case, the Save As property view appears. 
By default, the File Path is the Cases sub-directory in your HYSYS directory. 

In the File Name field, type a name for the case, for example gasplant. You do not have to 
enter the .hsc extension; HYSYS automatically adds it for you. Once you have entered a 
file name, press Enter or click Save.  
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2. Entering the Simulation Environment 
Up until now you have been working in the 
properties environment. Now that the components 
list and fluid packages have been set up, you can 
move to the simulation environment. 

To enter the Simulation Environment, click the 
Simulation bar on the lower left corner, in the 
navigation pane.   

In the Simulation environment, a number of 
different items are now available in the ribbon bar. 
The Process Flow Diagram and the Object Palette 
are open on the desktop.  

When completed, the PFD represents the flowsheet 
topology for a case. It shows the operations and 
streams and the directions of flows between them. 
You can also attach information tables or 
annotations to the PFD. 

2.1. Installing the Feed Streams 
In general, the first thing you do in the Simulation environment is to install one or more 
feed streams. The following procedure explains how to create and set up a new stream 
from the Object Palette. 

1. On the Object Palette, click the blue Material Streams button.  

2. Click within the PFD area. The stream is added, showing a blue arrow icon and a 
number as a default stream name.  

2.1.1. Enter Feed Conditions 
Next you will define the minimum feed conditions. You’ll name the stream and define the 
temperature, pressure and molar flow. 

1. Double click the stream icon to open the stream’s property view window. Most 
HYSYS property views are divided into tabs, and each tab is divided into pages. It 
should open to the Worksheet Tab, Conditions Page. 

2. In the Stream Name field, enter Feed 1. 

3. Type 60 in the Temperature cell. In the Unit drop-down list, HYSYS displays the 
default units for temperature, in this case F. This is the correct unit for this 
exercise. Press Enter. 

Figure 6 - Enter the Simulation Environment 
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The active location moves to the Pressure cell. If you know the stream pressure in 
another unit besides the default unit of psia, HYSYS will accept your input in any 
one of the available different units and automatically convert the supplied value to 

the default unit for you. For this 
example, the pressure of Feed 1 is 
41.37 bar. 

4. In the Pressure cell, type 41.37. 
Click the down arrow icon in the Unit 
drop-down list to open the list of units.  
Either scroll through the list to find bar, 
or begin typing it. HYSYS will match 
your input to locate the required unit. 
Once bar is selected, press Enter.  

HYSYS automatically converts the 
pressure to the default unit, psia, and 
the active selection moves to the Molar 
Flow cell. 

5. In the Molar Flow cell, type 6 and press Enter. The default Molar Flow unit is 
already MMSCFD, so you do not have to modify the units. 

2.1.2. Define the Stream Composition 
Now we need to define how much of each component exists in the stream.  

1. Click Composition under the Worksheet tab to go to the Composition page. By 
default, the components are listed by Mole Fractions. 

2. Click on the Mole Fractions cell for Nitrogen. Type 0.01 and press Enter. The Input 
Composition for Stream property view appears. 

This view is designed to streamline the specification of a stream composition and 
complete the stream’s compositional input. 

3. Click on the Mole Fractions cell for CO2, type 0.01, then press Enter. 

4. Enter the remaining fractions as shown below. 

Nitrogen .01 
CO2 .01 
Methane .6 
Ethane .2 
Propane .1 
i-Butane .04 
n-Butane .04 

When you have entered the fraction of each component the total at the bottom of 
the property view will equal 1.0000. 

Figure 7 - Setting Up a Material Stream 
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5. Click OK, and HYSYS accepts the 
composition. The stream is now 
defined, so HYSYS flashes it at 
the conditions given to determine 
its remaining properties. 

In the Feed 1 property view, click 
Conditions to go back to the conditions 
page. The calculated properties of Feed 
1 are now entered. The values you specified are in blue and the calculated values are in 
black. For streams with multiple phases, scroll horizontally to view the properties of each 
phase. New or updated information is automatically transferred among all locations in 
HYSYS.  

Note: The following table describes the methods available to determine stream 
composition on the Input Composition property view: 

Composition 
Basis Radio 
Buttons 

Lets you input the stream composition in some fractional basis 
other than Mole Fraction, or by component flows, by selecting the 
appropriate radio button before providing your input. 

Normalizing Lets you enter the relative ratios of components; for example, 2 
parts N2, 2 parts CO2, 120 parts C1, etc. Rather than manually 
converting these ratios to fractions summing to one, enter the 
individual numbers of parts and click the Normalize button. HYSYS 
will compute the individual fractions to total 1.0. 

Normalizing is also useful when you have a stream consisting of 
only a few components. Instead of specifying zero fractions (or 
flows) for the other components, enter the fractions (or the actual 
flows) for the non-zero components, leaving the others <empty>. 
Click the Normalize button, and HYSYS will force the other 
component fractions to zero. 

Calculation 
status/color 

As you input the composition, the component fractions (or flows) 
initially appear in red, indicating the final composition is unknown. 
These values will become blue when the composition has been 
calculated. Three scenarios result in the stream composition being 
calculated: 

• Input the fractions of all components, including any zero 
components, such that their total is exactly 1.0000. Then click 
OK. 

• Input the fractions (totalling 1.000), flows or relative number of 
parts of all non-zero components. Click the Normalize button, 
then OK. 

• Input the flows or relative number of parts of all components, 
including any zero components, then click OK. 

The red and blue text are the default colors; yours may appear 
different depending on your settings on the Colors page of the 
Session Preferences property view. 

Figure 8 - Defining Stream Composition 
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2.2. Create a Second Feed Stream 
1. Use the Object palette to add a second material stream, and define the conditions 

this way: 

Name Feed 2 
Temperature 60 
Pressure 600 
Molar Flow 4 

2. Next, select the Composition page and click the Edit button. The Input Composition 
for Stream property view 
appears.  

The current Composition Basis 
setting is Mole Fraction, the 
Preferences default. You must 
enter the stream composition on 
a Mass basis. Change the 
Composition Basis to Mass 
Fractions.  

3. Input the mass fractions 
for the remaining components 
as shown below: (Feed 2 does 
not contain CO2, so it will 
remain undefined).  

Nitrogen 0.02 Ethane 0.20 
CO2  <empty> Propane 0.20 
Methane 0.40 i-Butane 0.10 
  n-Butane 0.08 

4. Click Normalize once you have entered the values. 

5. Click OK to close the property view and return to the stream view. HYSYS performs 
a flash calculation to determine the unknown properties of Feed 2, as indicated by 
the green OK status bar. 

2.3. Analysis Tools: Phase Diagram 
HYSYS can attach a variety of analysis and monitoring tools to flowsheet objects. Here 
you will see how to attach a phase diagram for a material stream using the HYSYS 
Envelope Analysis tool. 

An Analysis tool is a separate entity from the stream or other object it is attached to. If 
you delete it, the host object is not affected. Likewise, if you delete the stream the tool 
will remain as an object in one of Analysis folders of the navigation pane, but will not 
display any information until you attach another stream to it. 

Figure 9 -  Enter the stream composition on a Mass basis. 
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1. On the property view for stream Feed 
2, click the Attachments tab, then 
select the Analysis page. 

2. Click Create. 

3. In the Available Analysis property 
view, select Envelope and click Add. 
The Envelope Analysis property view 
appears. Click the Performance tab. 
HYSYS creates and displays a phase 
envelope plot for the stream.  

Right click the graph to show the 
display, zoom and print controls. 

4. Click the Performance tab, then select 
the Plots page. The default Envelope Type is PT. To view another envelope type, 
select the appropriate radio button in the Envelope Type group. Depending on the 
type of envelope selected, you can specify and display Quality curves, Hydrate 
curves, Isotherms, and Isobars.  

To make the envelope property view more readable, maximize or re-size the 
property view. 

To view the data in a tabular format, select the Table page.  

5. Close the Analysis and Feed 2 property views. 

2.4. Installing the Mixer 
In the last section you defined the feed streams. Now you will install the unit operations 

for processing the gas.  

The first operation you will 
install is a Mixer, used to 
combine the two feed 
streams. As with most tasks 
in HYSYS, installing an 
operation can be 
accomplished in a number of 
ways. One method is through 
the Unit Ops tab of the 
Workbook. The Workbook is 
a spreadsheet-like view of 
the whole simulation, divided 
into object types and 
simulation environments. You 

Figure 10 - Applying the Envelope Analysis 

Figure 11 - Adding the mixer from the Workbook window 
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can use the Workbook as an alternative way to add, edit or delete operations from the 
case. 

1. Click the Workbook folder in the navigation pane. Click the Unit Ops tab of the 
Workbook. 

2. Click Add UnitOp. The UnitOps selector appears, listing all available unit operations.  

3. Select Mixer and Click Add. The Mixer is added and the Mixer property view 
appears. Click Cancel to close the UnitOps selector. 

As with a stream, a unit operation’s property view contains all the information defining the 
operation, organized in tabs and pages. (The four tabs shown for the Mixer: Design, 
Rating, Worksheet, and Dynamics, appear in the property view for most operations.)  

HYSYS enters the default name MIX-100 for the Mixer. As with streams, the default 
naming scheme for unit operations can be changed on the Session Preferences property 
view. 

Many operations such as the Mixer accept multiple feed streams. When you see a table 
like the one in the Inlets group, the operation will accept multiple stream connections at 
that location. When the Inlets table has focus, you can access a drop-down list of 
available streams. 

The status bar at the bottom of the property view shows that the operation requires a 
feed stream. 

1. In the Inlets group, click the arrow next to the <<Stream>> cell.  

2. Select Feed 1 from the list. The stream is added to the list of Inlets, and 
<<Stream>> automatically moves down to a new empty cell. 

3. Repeat to connect the other stream, Feed 2. 

The status indicator now displays “Requires a product stream”. Here you’ll see how to add 
a new stream to the flowsheet directly from a unit operation.  

1. Click in the Outlet field. 

2. Type MixerOut in the cell and press Enter. HYSYS recognizes that there is no 
existing stream named MixerOut, so it creates a new stream with this name. The 
status indicator now displays a green OK, indicating that the operation and attached 
streams are 
completely 
calculated. 

3. Click the 
Parameters page.  

4. In the Automatic 
Pressure 
Assignment group, 
leave the default 
setting at Set 
Outlet to Lowest 
Inlet.  

Figure 12 - The Mixer calculates the MixerOut stream. 
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HYSYS has calculated the outlet stream by combining the two inlets and flashing the 
mixture at the lowest pressure of the inlet streams. In this case, both inlets have the 
same pressure (600 psia), so the outlet stream is set to 600 psia. 

To view the calculated outlet stream values, click the Worksheet tab and select the 
Conditions page. The Worksheet tab is a condensed Workbook property view, displaying 
only those streams attached to the selected operation. 

Now that the Mixer is completely defined, close the property view to return to the 
Workbook. The new operation appears in the table on the Unit Ops tab of the Workbook.  

The table shows the operation Name, its Object Type, the attached streams (Feeds and 
Products), whether it is Ignored in the simulation, and its Calculation Level.  

When you select an operation in the table and click View UnitOp, the view for the 
selected operation appears. Alternatively, double-clicking on any cell (except Inlet, Outlet, 
and Ignored) associated with the operation also opens the operation property view. 

When any of the Name, Object Type, Ignored, or Calc. Level cells are active, the box at 
the bottom of the Workbook displays all streams attached to the current operation. 
Currently, the Name cell for MIX-100 has focus, and the box displays the three streams 
attached to this operation. 

You can also open the property view for a stream directly from the Unit Ops tab.  

2.5. Installing the Inlet Separator 
Next you will install and define the inlet separator, which splits the two-phase MixerOut 
stream into its vapour and liquid phases.  

1. Click Workbook in the navigation Pane, and in the Workbook view, click Unit Ops. 

2. Click Add UnitOp, and select Separator.  

3. Click Add. The Separator property view appears, displaying the Connections page 
on the Design tab.  

4. In the Name cell, change the name to InletSep and press Enter. 

5. Click the arrow to the right of the <<Stream>> cell and select the stream 
MixerOut. 

6. In the Vapour Outlet cell, type SepVap in the field and press Enter to create the 
vapour outlet stream. 

7. Click on the Liquid Outlet cell, type the name SepLiq, and press Enter. (An Energy 
stream could be attached to heat or cool the vessel contents but for this tutorial the 
energy stream is not required.) 

8. Click the Design tab - Parameters page. The current default values for Delta P, 
Volume, Liquid Volume, and Liquid Level are acceptable. 

The Volume, Liquid Volume, and Liquid Level default values generally apply only to 
vessels operating in dynamic mode or with reactions attached. 



Gas Processing Tutorial  1-15 
 
 

Getting Started with Aspen HYSYS  15 
 

9. To view the calculated outlet stream data, click the Worksheet tab - Conditions 
page. When finished, close the separator property view.  

2.6. Using Workbook Features 
Before installing the remaining operations, you will look at a number of Workbook features 
that let you access information quickly and change how information is displayed. Once the 
flowsheet is established, advanced users rely on the workbook quite a bit; this is a good 
time to get familiar with it. 

2.6.1. Tip: Access Operation Controls from the Workbook 
Any cell in the workbook functions as a link to its parent object. If you double click a unit 
operation name, the control view for that operation opens. If you double click a stream 
name, or even a value listed under a stream heading, the stream’s property view opens.  

Try this: Click on any cell associated with the stream SepVap, found on the Material 
Streams tab. The list at the bottom of the form shows the operations to which this stream 
is attached. To access the property view for either of these operations, double-click on the 
operation name.  

2.6.2. Add a Variable-Specific Tab to the Workbook  
You can customize the Workbook to display specific information. In this section you will 
create a new Workbook tab that displays only stream pressure, temperature, and flow. 

1. Select Workbook from the navigation pane.  

2. In the Ribbon, select the Workbook tab.  

3. In the Workbook ribbon, click Setup. The Workbook Setup property view appears. 

The four existing tabs are listed in the Workbook Tabs box. When you add a new tab, it 
will be inserted before the highlighted tab (currently Material Streams). 

1. In the Workbook Tabs group list, select the Compositions tab. 

2. In the Workbook Tabs group, click Add. The New Object Type property view 
appears.  

3. Click the icon beside Stream to expand the tree branch into Material Stream and 
Energy Streams. 

4. Select the Material Stream and click OK. You will return to the Setup property view, 
and the new tab appears in the list after the existing Material Streams tab. 

5. In the Object group, click in the Name cell and change the name for the new tab 
from the default Streams 1 to P,T,Flow to better describe the tab contents. 

Next you will customize the tab by removing the irrelevant variables. 
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6. In the Variables group, hold the CTRL key and select Vapour Fraction, Mass Flow, 
Heat Flow, and Molar Enthalpy. Four variables are now selected. Release the CTRL 
key. 

7. Click the Delete button. The variables are removed from the list.  

Close the Setup property view to return to the Workbook property view and check the 
new tab. At this point, save your case. 

 
Figure 13 - The new variable-specific tab added to the workbook 

2.7. Installing the Heat Exchanger 
Next, you will install the gas/gas heat exchanger. Up to now you have created five 
streams and two unit operations without referring to the flowsheet. For the heat 
exchanger, we’ll apply it directly to the flowsheet using the Object Palette. If you are still 
in the Workbook view, click View > Flowsheet on the Ribbon. You’ll see the basic layout 
automatically placed for you.  

 
Figure 14 - Objects automatically placed in the flowsheet. 

Press F4 to open the Object Palette. 

On the Object Palette, double-click the Heat Exchanger icon. The Heat Exchanger property 
view opens to the Connections page on the Design. 

1. In the Name field, change the operation name from its default E-100 to Gas/Gas. 

2. Attach the Inlet and Outlet streams as shown below, using the methods learned in 
the previous sections. You will have to create all streams except SepVap, which is 
an existing stream that can be selected from the Tube Side Inlet drop-down list. 
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Field Value 

Name Gas/gas 

Tube Side Inlet SepVap 

Shell Side Inlet LTSVap 

Tube Side Outlet CoolGas 

Shell Side Outlet SalesGas 

3. Click the Parameters page. There are several heat exchanger models to choose 
from - the Simple End Point model is the default setting and is acceptable for this 
tutorial. 

4. Enter 10 psi for the pressure drop in both the Tube and Shell Side Delta P.   

5. Click the Rating tab, then select the Sizing page. In the Configuration group,  
change the Tube Passes per Shell cell value to 1, to model Counter Current Flow.  

Close the Heat Exchanger view and return to the Material Streams tab of the Workbook 
property view. 

The new stream CoolGas has not been flashed yet, as its temperature is unknown. The 
CoolGas stream will be flashed later when a temperature approach is specified for the 
Gas/Gas heat exchanger. Notice how partial information is passed (for stream CoolGas) 
throughout the flowsheet. HYSYS always calculates as many properties as possible for the 
streams based on the available information. 

 
Figure 15 - Back in the workbook view - the Heat Exchanger streams are not solved yet. 

2.7.1. Tip: Arranging the PFD 
If the streams or operations are not all visible, you can go to the Flowsheet /Modify ribbon 
tab and in the Flowsheet field, click the tiny down arrow in the lower left corner of the 
field. Click Auto Position All from the Additional Commands menu. HYSYS now displays all 
streams and operations, arranging them in a logical manner. The View ribbon – Zoom to 
Fit command is also useful in centering the flowsheet.  
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Figure 16 - Access flowsheet position 
commands from the tiny down-arrow 

 

 
 

As a graphic representation of your simulation, the PFD shows the connections among all 
streams and operations. As in the workbook, you can open the property view for an object 
by double-clicking its icon. 

Placing the cursor over an object shows a “fly-by’ summary of information. Each object, 
when selected, has a right click menu of specialized options.  

2.7.2. Tip: PFD Color Codes and Calculation Status 
Before proceeding, take a look at how the PFD lets you trace the calculation status of the 
objects in your flowsheet. If you recall, the status indicator at the bottom of a property 
view for a stream or operation displayed three different states for the object: 

Indicator 
Status 

Description 

Red  A major piece of defining information is missing from the object. For 
example, a feed or product stream is not attached to a Separator. 
The status indicator is red, and an appropriate warning message 
appears. 

Yellow  All major defining information is present, but the stream or operation 
has not been solved because one or more degrees of freedom is 
present. For example, a Cooler where the outlet stream temperature 
is unknown. The status indicator is yellow, and an appropriate 
warning message appears 

Green  The stream or operation is completely defined and solved. The status 
indicator is green, and an OK message appears. 

Keep in mind that the above colors are the HYSYS default colors. You can 
change/customize the colors in the Session Preferences. 
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Figure 17 - The Flowsheet with the Gas-Gas Heat Exchanger 

When you are working in the PFD, the streams and operations are also color-coded to 
indicate their calculation status. The mixer and inlet separator are completely calculated, 
so they have a black outline. For the heat exchanger Gas/Gas, however, the conditions of 
the tube side outlet and both shell side streams are unknown, so the exchanger has a 
yellow outline indicating its unsolved status. 

Colors also show the status of streams. For material streams, a dark blue icon indicates 
the stream has been flashed and is entirely known. A light blue icon indicates the stream 
cannot be flashed until some additional information is supplied. Similarly, a dark red icon 
indicates an energy stream with a known duty, while a purple icon indicates an unknown 
duty. 

The icons for all streams installed to this point are dark blue except for the Heat 
Exchanger shell-side streams LTSVap and SalesGas, and tube-side outlet CoolGas. 

2.8. Installing the Chiller 
In the next step you will install a chiller, which will be modelled using a Cooler unit 
operation.  

• Press F4 to access the Object Palette 

The Chiller will be added to the right of the LTS, so make some empty space available in 
the PFD by scrolling to the right using the horizontal scroll bar. 

1. Click the Cooler icon on the Object Palette.  

2. Position the cursor over the PFD.  
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Figure 18 - Drop the cooler to the right of the Inlet Separator 

3. Click on the PFD where you want to drop the Cooler.  

HYSYS creates a new Cooler with a default name, E-100. The Cooler icon has a red status 
(and color), indicating that it requires feed and product streams.  

2.8.1. Connecting the Chiller 
This is how to make the stream-to-unit operation connections graphically. (You can also 
connect them from within the unit operation’s connections form, by picking the steam to 
connect from a list.) 

1. Click the Attach icon in the Flowsheet/ Modify ribbon to enter Attach mode. (When 
you are in Attach mode, you will not be able to move objects in the PFD. You can 
temporarily toggle between Attach and Move mode by holding down the CTRL key. 
To return to Move mode, click the Attach icon again.) 

2. Hold the cursor over the right end of the CoolGas stream icon. A small box appears 
at the cursor tip. Through the transparent box, you can see a square connection 
point, and a pop-up description attached to the cursor tail. The pop-up “Out” 
indicates which part of the stream is available for connection, in this case the 
stream outlet. 

3. With the pop-up “Out” visible, click and hold. The transparent box becomes solid 
black, indicating that you are beginning a connection. 

4. Still holding down, move the cursor toward the left (inlet) side of the Cooler. A 
trailing line appears between the CoolGas stream icon and the cursor, and a 
connection point appears at the Cooler inlet. 

5. Place the cursor near the connection point, and the trailing line snaps to that point. 
A solid white box appears at the cursor tip, indicating an acceptable end point for 
the connection.  

6. Release the left mouse button, and the connection is made to the connection point 
at the Cooler inlet. 
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Figure 19 - Use Attach mode to 
graphically attach CoolGas  to the chiller 
operation. 

2.8.2. Graphically Add Outlet and Energy Streams 
Position the cursor over the right end of the Cooler icon. The connection point and the 
pop-up “Product” appears. 

1. With the pop-up visible, left-click and hold. The white box again becomes solid 
black. 

2. Move the cursor to the right of the Cooler. A white stream icon appears with a 
trailing line attached to the Cooler outlet. The stream icon shows that a new stream 
will be created after the next step is completed. 

3. With the white stream icon visible, release the left mouse button. HYSYS creates a 
new stream with the default name 1. 

4. Repeat the steps to create the Cooler energy stream, originating the connection 
from the arrowhead on the Cooler icon.  

The new stream is automatically named Q-100. The Cooler has yellow (warning) 
status, indicating that all necessary connections have been made but the attached 
streams are not entirely known. 

5. Click the Attach Mode icon again to return to Move mode. 

Tip: To break an incorrect connection: 
1. Click the Break Connection icon on the PFD toolbar. 

2. Move the cursor over the stream line connecting the two icons. A checkmark 
attached to the cursor appears, indicating an available connection to break. 

3. Click once to break the connection. 

2.9. Defining the Material and Energy Streams 
The Cooler material streams and the energy stream are unknown at this point, so they are 
light blue and purple, respectively. 

1. Double-click the Cooler icon to open its property view.  
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2. On the Connections page, the names of the Inlet, Outlet, and Energy streams that 
you recently attached appear in the appropriate cells.  

3. In the Name field, change the operation name to Chiller. 

4. Select the Parameters page. In the Delta P field, specify a pressure drop of 10 psi. 

5. Close the Cooler property view. 

At this point, the Chiller has two degrees of freedom; one of these will be eliminated when 
HYSYS flashes the CoolGas stream after the exchanger temperature approach is specified. 

To use the remaining degree of freedom, either the Chiller outlet temperature or the 
amount of duty in the Chiller energy stream must be specified. The amount of chilling 
duty which is available is unknown, so you will provide an initial guess of 0 F for the 
Chiller outlet temperature. Later, this temperature can be adjusted to provide the desired 
sales gas dew point temperature. 

1. Double-click on the outlet stream icon (1) to open its property view. 

2. In the Name field, change the name to ColdGas. 

3. In the Temperature field, specify a temperature of 0 degrees F. 

The remaining degree of freedom for this stream has now been used, so HYSYS 
flashes ColdGas to determine its remaining properties. Close the ColdGas property 
view and return to the PFD property view. 

The Chiller still has yellow status, because the temperature of the CoolGas stream 
is unknown. 

4. Double-click the energy stream icon (Q-100) to open its property view. The 
required chilling duty (in the Heat Flow cell) is calculated by HYSYS when the Heat 
Exchanger temperature approach is specified in a later section. 

5. Rename the energy stream C3Duty and close the property view.  

2.10. Installing the Low-Temperature Separator (LTS) 
Now that the chiller has been 
installed, the next step is to install 
the low-temperature separator (LTS) 
to separate the gas and condensed 
liquids in the ColdGas stream. 

2.10.1. Adding and 

Connecting the LTS 
Make some empty space available to 
the right of the Chiller using the 
horizontal scroll bar. 

Figure 20 - Connect the LTS 



Gas Processing Tutorial  1-23 
 
 

Getting Started with Aspen HYSYS  23 
 

1. Position the cursor over the Separator icon on the Object Palette. 

2. Click, hold, and drag the cursor over the PFD to the right of the Chiller. Release the 
right mouse button to drop the Separator onto the PFD. A new Separator appears 
with the default name V-100. 

The Separator will have two outlet streams, liquid and vapour. The vapour outlet 
stream LTSVap, which is the shell side inlet stream for Gas/Gas, has already been 
created. The liquid outlet will be a new stream. 

3. Double click the separator to open its property view. In the Design Connections 
page, set up the connections like this: 

Inlets Coldgas (pick from list) 

Vapor outlet LTSVap (pick from list) 

Liquid Outlet LTSLiq (Type in as new) 

4. In the Name field, change the name to LTS. Close the LTS property view.  

2.10.2. Adding a Heat Exchanger Specification 
At this point, the outlet streams from the Gas/Gas heat exchanger are still unknown.  

1. Double-click on the Gas/Gas icon to open the exchanger property view. 

2. Click the Design tab - Specs page. 

The Specs page lets you input specifications for the Heat Exchanger. The Solver group on 
this page shows that there are two Unknown Variables and the number of Constraints is 1, 
so the remaining Degrees of Freedom is 1. HYSYS provides two default constraints in the 
Specifications group, although only one has a value: 

Specification Description 

Heat Balance  The tube side and shell side duties must be equal, so the heat 
balance must be zero (0). 

UA  This is the product of the overall heat transfer coefficient (U) and the 
area available for heat exchange (A). HYSYS does not provide a 
default UA value, so it is unknown at this point. It will be calculated 
by HYSYS when another constraint is provided. 

To use the remaining degree of freedom, a 10 degree F minimum temperature approach 
to the hot side inlet of the exchanger will be specified. 

1. In the Specifications group, click the Add button. 
The ExchSpec (Exchanger Specification) view 
appears. 

2. In the Name cell, change the name to Hot Side 
Approach. 

The default specification in the Type cell is Delta Temp, 
which allows you to specify a temperature difference 
between two streams. The Stream (+) and Stream (-) 
cells correspond to the warmer and cooler streams, 
respectively. 

Figure 21 - Hot Side Approach setup 
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• In the Stream (+) cell, select SepVap from the drop-down list. 

• In the Stream (-) cell, select SalesGas from the drop-down list. 

• In the Spec Value cell, enter 10 degrees F.  

HYSYS will converge on both specifications and the unknown streams will be flashed. 

2.10.3. Review Results 
1. Close the ExchSpec property view to return to the Gas/Gas property view. The new 

specification appears in the Specifications group on the Design tab - Specs page. 

2. Click the Worksheet tab - Conditions page to view the calculated stream properties.  

Using the 10 degree F approach, HYSYS calculates the temperature of CoolGas as 
42.9 degrees F. (Very slight differences may result in different versions of HYSYS.) 
All streams in the flowsheet are now completely known. 

3. Click the Performance tab, then select the Details page, where HYSYS displays the 
Overall Performance and Detailed Performance. 

 
Figure 22 - Calculations for the Gas-gas exchanger 

Two parameters of interest are the UA and LMTD (logarithmic mean temperature 
difference), which HYSYS has calculated as 2.08e4 Btu/F-hr and 22.6 degrees F, 
respectively.  

4. When you are finished reviewing the results, close the Gas/Gas property view. 

2.11. Checking the Sales Gas Dew Point 
The next step is to check the SalesGas stream to see if it meets a dew point temperature 
specification. This is to ensure that no liquids form in the transmission line. A typical 
pipeline dew point specification is 15 degrees F at 800 psia, which will be used for this 
example. 

To test the current dew point you will  

1. Create a stream with a composition identical to SalesGas,  
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2. Specify the dew point pressure, and  

3. Have HYSYS flash the new stream to calculate its dew point temperature.  

To do this you will install a Balance operation. 

2.11.1. Install the Balance Operation 
1. Double-click the Balance icon on the Object Palette. The property view for the new 

operation appears. 

2. In the Name field, type DewPoint. In the <<Stream>> cell in the Inlet Streams 
table, select SalesGas. 

3. In the <<Stream>> cell in the Outlet Streams table, create the outlet stream by 
typing SalesDP, (Sales Dew Point) then press Enter. Changes made to the vapor 
fraction, temperature or pressure of the new outlet stream SalesDP will not affect 
the rest of the flowsheet. However, changes which affect the inlet stream SalesGas 
will cause SalesDP to be re-calculated because of the molar balance between these 
two streams.   

4. Click the Parameters tab.  

5. In the Balance Type group, select the Component Mole Flow radio button. 

The vapour fraction and pressure of SalesDP can now be specified, and HYSYS will 
perform a flash calculation to determine the unknown temperature.  

1. Click the Worksheet tab.  

2. In the SalesDP column, Vapour cell, enter 1.0. 

3. In the Pressure cell, enter 800 psia. 

HYSYS flashes the stream at these conditions, returning a dew point Temperature of 5.27 
degrees F, which is well within the pipeline allowance of 15 degrees F. 

Close the DewPoint property view to 
return to the PFD. 

Note: When HYSYS created the Balance 
and the new stream, their icons were 
probably placed in the far right of the 
PFD. If you like, you can click and drag 
the Balance and SalesDP icons to a 
more appropriate location, such as 
immediately to the right of the 
SalesGas stream. 

2.12. Install the Second Mixer  
In this section you will install a second mixer, which is used to combine the two liquid 
streams, SepLiq and LTSLiq, into a single feed for the Distillation Column. 

Figure 23 - Enter Vapor and pressure for SalesDP. 
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1. In the PFD, make some empty space available to the right of the LTS using the 
horizontal scroll bar. 

2. Click and hold the left mouse button on the Mixer icon in the Object Palette, and 
drag the icon to the right of the LTSLiq stream icon. Release to drop the Mixer onto 
the PFD.  

3. Open the Connections form for the mixer. In the inlets field, select the streams 
LTSLiq and SepLiq.  

4. For the outlet field, type in the new stream 
name TowerFeed, and press Enter. 

5. Now, still in the form, right-click the name 
TowerFeed, and click View in the pop up 
menu. The property view for the new stream 
opens. HYSYS has automatically combined 
the two inlet streams and flashed the 

mixture to determine the outlet conditions.  

Close the property views. 

2.13. Install the Depropanizer Column 
Columns are usually the most complex unit operations in a simulation. HYSYS has a 
number of pre-built column templates that you can install and customize by changing the 
default specifications. In this section, you will use one of these to install and configure a 
distillation column. 

First, go to the File – Options Button – Simulation Options form and be sure that the Use 
Input Experts checkbox is checked. This brings up a wizard-like sequence of setup 
windows when you add a column that help you specify the column operation.  

On the Object Palette, select the Columns tab, and double-click the Distillation Column 
Sub-Flowsheet icon. The first page of the Input Expert property view appears. 

2.13.1. Define the Column Stages 
When you install a column template, HYSYS supplies default information such as the 
number of stages. The current active cell is # Stages (Number of Stages), indicated by 
the thick border around this cell and the presence of 10 (the default number of stages).  

Some points worth noting: 

• These are theoretical stages, as the HYSYS default stage efficiency is one. If you 
want to specify real stages, you can change the efficiency of any or all stages later. 

• The Condenser and Reboiler are considered separate from the other stages, and are 
not included in the Number of Stages field. 

Figure 24 - Right click the stream name to view 
stream properties 
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For this example, 10 theoretical stages will be used, so leave the Number of Stages at its 
default value. 

 

1. Click on the <<Stream>>  dropdown list in the Inlet Streams table. Select 
TowerFeed as the inlet feed stream to the column. 

HYSYS supplies a default feed location in the middle of the Tray Section (TS), in 
this case stage 5 (5_Main TS). This default location is used, so there is no need to 
change the Feed Stage. 

2. This column has Overhead Vapour and Bottoms Liquid products, but no Overhead 
Liquid (distillate) product. 

In the Condenser group, select the Full Rflx radio button. The distillate stream is 
removed. This is the same as leaving the Condenser as Partial and later specifying 
a zero distillate rate. 

3. Enter the stream and column names as shown below. 

Column Name DePropanizer 

Stream TowerFeed 

Condenser Energy Stream CondDuty 

Ovhd Vapor Outlet Ovhd 

Reboiler Energy Stream RebDuty 

Bottoms Liquid Outlet LiquidProd 

 

 

Figure 25 - Page One of the Column Input 
Expert 

When you are finished, the Next button becomes active, and you can go to the next page 
of the Input Expert.  

1. Click Next to go to the Reboiler Configuration View. Select the default Once-
through, Regular HYSYS reboiler sections. 

2. Click Next to advance to the Pressure Profile page. 
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In the Condenser Pressure field, enter 200 psia. 

In the Reboiler Pressure field, enter 205 psia. 

The Condenser Pressure Drop can be left at its default value of zero.  

3. Click Next to advance to the Optional Estimates page. (Although HYSYS does not 
require estimates to produce a converged column, good estimates will usually result 
in a faster solution.) Specify a Condenser temperature of 40°F and a Reboiler 
Temperature Estimate of 200°F.  

4. Click Next to advance to the Specifications page of the Input Expert. The 
Specifications page allows you to supply values for the default column specifications 
that HYSYS has created. 

5. Enter a Vapour Rate of 2.0 MMSCFD and a Reflux Ratio of 1.0. 

The Flow Basis applies to the Vapour Rate, so leave it at the default of Molar.  

In general, a Distillation Column has three default specifications, however, by 
specifying zero overhead liquid flow (Full Reflux Condenser) one degree of freedom 
was eliminated. For the two remaining default specifications, overhead Vapour Rate 
is an estimate only, and Reflux Ratio is an active specification. 

6. Click the Done button. The Distillation Column property view appears.  

Now, select the Design tab - Monitor page. The Monitor page displays the status of your 
column as it is being calculated, updating information with each iteration. You can also 
change specification values and activate or de-activate specifications used by the Column 
solver directly from this page. 

2.13.2. Adding a Column Specification 
The current Degrees of Freedom number is zero, indicating the column is ready to be run. 
The Vapour Rate you specified in the Input Expert, however, is currently an active 
specification, and you want to use this only as an initial estimate for the solver for this 
exercise.  

1. In the Ovhd Vap Rate row, uncheck the Active checkbox. Leave the Estimate 
checkbox checked. 

 

Figure 26 - Uncheck the vapor rate in the Active 
Column 

The Degrees of Freedom increases to 1, indicating that another active specification 
is required. For this example, we will specify a 2% propane mole fraction in the 
bottoms liquid. 
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2. Select the Specs page. This page lists all the Active and non-Active specifications 
which are required to solve the column.  

3. In the Column Specifications group, click 
Add. The Add Specs property view appears. 

4. From the Column Specification Types list, 
select Column Component Fraction. Click the 
Add Spec(s) button. The Comp Frac Spec 
property view appears. 

5. In the Name cell, change the specification 
name to Propane Fraction. 

6. In the Stage cell, select Reboiler from the 
drop-down list of available stages.  

7. In the Spec Value cell, enter 0.02 as the 
liquid mole fraction specification value. 

8. Click in the first cell <<Component>> in the Components table, and select Propane 
from the drop-down list of available components.  

Click the X to close this property view to return to the Column view. The new spec 
appears in the Column Specifications list on the Specs page. HYSYS automatically made 
the new specification active when you created it. 

Return to the Monitor page. The new specification may not be visible unless you scroll 
down the table because it has been placed at the bottom of the Specifications list. 

Click the Group Active button to bring the new specification to the top of the list, directly 
under the other Active specification. The Degrees of Freedom has returned to zero, so the 
column is ready to be calculated. 

2.13.3. Running the Column 
Click the Run button at the bottom of the Column property view to begin calculations. The 
information displayed on the Monitor page is updated with each iteration. The column 
converges quickly, in three iterations. 

The table in the Optional Checks group displays the Iteration number, Step size, and 
Equilibrium error and Heat/Spec error. 

The column temperature profile appears 
in the Profile group. You can view the 
pressure or flow profiles. 

The status indictor has changed from 
Unconverged to Converged. 

Click the Performance tab, then select 
the Column Profiles page to access a 
more detailed stage summary. 
Figure 28 - The Column Converges 

Figure 27 - Add a Column Component Fraction 
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Tip: Accessing the Column Sub-flowsheet 
A column template uses its own flowsheet to represent its internal workings, the flows 
between the tower, reboiler and condenser, etc. When working with the column, you 
might want to focus only on the connections in the column sub-flowsheet. You can do this 
by entering the column environment. 

Click the Column Environment button at the bottom of the column property view. HYSYS 
now displays the Column Sub-flowsheet environment.  

When you are finished in the column environment, return to the main flowsheet by 
clicking the icon in the tool bar or the Parent Environment button on the bottom left of the 
Column Form. 

2.14. Viewing and Analyzing Results 
Use the Workbook folder on the navigation pane to open the Workbook for the main case 
and view the calculated results for all streams and operations. 

Click the Streams tab and the Compositions tab. 

2.15. Using Data Tables 
The HYSYS Data Tables provide a convenient way to examine your flowsheet in more 
detail. You can use the Data Tables to monitor key variables under a variety of process 
scenarios, and view the results in a tabular or graphical format. 

For this example, we will examine the effects of LTS temperature on the Sales Gas dew 
point and flow rate, and the Liquid Product flow rate. 

2.15.1. Creating the Data Table 
1. Click Data Tables in the Simulation environment navigation pane. 

2. Click Add in the Data Tables form. A new table is added to the Data Tables folder 
with the default name ProcData1. Right-click the name to rename the table to 
KeyVars. Here you will add the key variables. 

3. Click Add in the new data table. The Variable Navigator opens.  

The Variable Navigator is used extensively in HYSYS for locating and selecting 
variables. It operates in a left-to-right manner. In the Flowsheet column you see 
two listings: The case or main flowsheet, and in a subfolder, the column sub 
flowsheet.  

4. In the Object Filter group (right side of the form), select UnitOps.  

5. In the Object list, select the LTS.  
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6. In the Variable list, select Vessel Temperature. Click Add to add this variable to the 
Data Tables. 

7. Continue adding variables to the Data Tables:  

• In the Object Filter group, select the Streams radio button. Select SalesDP 
>Temperature. 

• In the Variable Description field, change description to Dew Point, then click 
Add.  

Repeat the previous steps to add the following variables to the Data Tables: 

• SalesGas stream; Molar Flow variable; change the Description to Sales Gas 
Production. 

• LiquidProd stream; Liq Vol Flow@Std Cond variable; change the Description 
to Liquid Production. 

8. Close the Variable Navigator. 

You can access this table again later to demonstrate how its results are updated whenever 
a flowsheet change is made. 

 
Figure 29 - Use the Variable navigator to set up a data table 

2.16. Modify the ColdGas Stream; Observe Results 
In this section, you will change the temperature of stream ColdGas (which determines the 
LTS temperature) and view the resulting changes for calculated values in the process data 
table. 

1. On the Navigation pane, expand the Streams folder, right-click the cursor over 
Streams > Coldgas and select Open in New Tab. This lets you have tabs open for 
both the KeyVars table and the ColdGas stream. 
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2. Right-click the Coldgas (Material Stream) tab and 
click New Vertical Tab Group from the shortcut 
menu. The Windows are arranged side by side.  

Currently, the LTS temperature is 0 degrees F. The key 
variables will be checked at 10 degrees F. 

In the ColdGas Temperature cell, type 10 degrees F. 
HYSYS automatically recalculates the flowsheet. The new 
results are shown. 

The change in Temperature generates the following 
results: 

• The Sales Gas flow rate has increased from 7.015 
MMSCFD to 7.358 MMSCFD. 

• The Liquid Product flow rate has decreased from 
478.9 barrel/day to 450.6 barrel/day. 

• The sales gas dew point has increased from 5.273 to 15.9 degrees F. We can see 
that this temperature no longer satisfies the dew point specification of 15 degrees 
F. 

Click the Close icon on the ColdGas stream property view and return to the Data Tables. 

 
Figure 31 - Compare the Variables at ColdGas temperatures of 0 and 10 degrees F. 

2.17. Case Complete 
The basic simulation for this example is now completed. You have learned how to use the 
HYSYS user interface to set up a new simulation file, specify components and methods, 
place material streams, connect them to unit operations, and use basic utilities to 
examine simulated data. You should now be able to open and examine more advanced 
techniques used in the other example cases for specific applications, or to begin building 
your own simulation case.  

Figure 30 - Click Open in new tab 


	Contents
	1. Introduction
	1.1 About This Case
	1.1. New Case and Session Preferences
	1.2. Create a New Unit Set
	1.3. Add Components to a Component List
	Tip: Multiple Component Lists
	Tip: Viewing or Editing Component Properties

	1.4. Selecting the Property Methods to Create a Fluid Package
	Tip: Multiple Fluid Packages
	Definitions for review:
	1.4.1. Save the Case


	2. Entering the Simulation Environment
	2.1. Installing the Feed Streams
	2.1.1. Enter Feed Conditions
	2.1.2. Define the Stream Composition

	2.2. Create a Second Feed Stream
	2.3. Analysis Tools: Phase Diagram
	2.4. Installing the Mixer
	2.5. Installing the Inlet Separator
	2.6. Using Workbook Features
	2.6.1. Tip: Access Operation Controls from the Workbook
	2.6.2. Add a Variable-Specific Tab to the Workbook

	2.7. Installing the Heat Exchanger
	2.7.1. Tip: Arranging the PFD
	2.7.2. Tip: PFD Color Codes and Calculation Status

	2.8. Installing the Chiller
	2.8.1. Connecting the Chiller
	2.8.2. Graphically Add Outlet and Energy Streams
	Tip: To break an incorrect connection:

	2.9. Defining the Material and Energy Streams
	2.10. Installing the Low-Temperature Separator (LTS)
	2.10.1. Adding and Connecting the LTS
	2.10.2. Adding a Heat Exchanger Specification
	2.10.3. Review Results

	2.11. Checking the Sales Gas Dew Point
	2.11.1. Install the Balance Operation

	2.12. Install the Second Mixer
	2.13. Install the Depropanizer Column
	2.13.1. Define the Column Stages
	2.13.2. Adding a Column Specification
	2.13.3. Running the Column
	Tip: Accessing the Column Sub-flowsheet

	2.14. Viewing and Analyzing Results
	2.15. Using Data Tables
	2.15.1. Creating the Data Table

	2.16. Modify the ColdGas Stream; Observe Results
	2.17. Case Complete


